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  Welcome From The Chief Editor


  



  I really need to start off this month's "Welcome" column with an apology. Normally, I write multiple articles for each issue of the magazine. But for the February 2016 issue, I only had time to write one other article, aside from this one, my customary "Welcome" column. Things have been B-U-S-Y.


  To start off with, I have to take "call" at the hospital where I work one day every two weeks. I don't know what's blowing in the wind, but we have been extremely busy. In fact, we've been so busy that I've gotten called in extra to work the last two times I've been on call. I have another call shift coming up Monday, February 1, and I'm already anticipating that I'll end up getting called in to work for that call shift, due to the increased workload.


  Then, on this past Christmas morning, we (my wife and me) found out we're expecting our second child! Here's the really trippy part: both children were conceived on the same day, we found out that we were pregnant with both of them on Christmas morning, my wife's temperature chart looks identical, and the due date for both was/is August 25 ... which is my birthday. My son must have wanted his own birthday, so he came early, on August 6.
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  Of course, winter days with REALLY nice weather are definitely not the norm for us here in the midwestern U.S. In fact, they are predicting a significant snowfall and bitterly cold temps within the next few days. So, we took my son to the park after getting done getting the sonogram at the OB-Gyn's office.
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  So between working the extra shifts at the hospital, doctor visits for the new pregnancy, making sure my son gets the time he needs and deserves from mom and dad, and everything else going on with life in general ... I found myself without the time I usually had available to write multiple articles. Hence, the apology. I'm hopeful that things will get back to "normal" for next month's magazine deadline.


  Until next month, I bid you peace, happiness, serenity and prosperity.


  

  


  Inkscape Tutorial: More Text Tricks


  



  by Meemaw


  It seems you can make practically any text design you want, and this tutorial taught me a lot I didn't know! I add text to many of my projects, and I always used the Text window to edit my text (correcting a misspelled word, changing the font and size, etc.), but I hadn't really paid attention to the toolbar that is directly above my work area. I found out that you can use text window (the "T" at the top of the window), but the toolbar just below it has more options ... many things can be done just using this toolbar
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  Going from left to right, we start with the normal settings: Font, Font Size, Font Style (Normal, Bold, Italic or a combination) and Alignment buttons. We even have two buttons for superscript and subscript, if needed. From there, however, we have six settings that can really make your text look different. Let's concentrate on this half of the toolbar.
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  The first one is line spacing. This is useful if you have more than one line of text. Inkscape's default is 1.25. Depending on how you set it, you can put letters right on top of each other (with a negative setting) or space them far enough apart that something can be put between them. One use for this could be the award certificates that some schools give to children. If you have a two-line statement, you can space it out enough to leave room for someone to write in the child's name. If you design your own certificates, this may work better for your spacing than using the Enter key several times in a row.
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  The second is letter spacing. This setting determines how close or far apart your individual letters are. A negative setting "smooshes" letters closer together, and a positive setting stretches the words out, as shown below. The center image is a zero setting, or "normal". This works well if you want to make a banner fitting a precise length.


  

  [image: ]



  The third of the settings is word spacing. You can stretch your sentence out as much as you want by increasing the space between each word. This might help on your banner design, or a newsletter headline or ad you want to emphasize.
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  The fourth one is kerning. This adjusts the letter spacing only between the letters you've selected (putting the cursor between the letters you want to space out). As you see below, I separated the "e" from the rest of the word "Time".
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  You can change the kerning on each letter individually to get a different look. If you play with it a bit and decide you don't like it, you can use the Undo function (<CTRL> + Z) which will undo them one at a time, or choose Text > Remove Manual Kerns to remove them all.


  Shift is next. Shift moves letters up or down. Place the cursor to the right of the letter you want to move, then change the setting. A positive setting moves it up and a negative setting moves it down.


  

  [image: ]



  Rotation is the last number setting in the toolbar. You can rotate the letters one at a time by placing your cursor to the left of the letter you want to rotate, then changing the setting to a positive or negative setting in degrees.


  You can also highlight each letter and change the color. I did the colors and rotated all of these. The rotation setting is zero because no letters are highlighted.
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  The last two buttons are text direction buttons. Most of the time you will want your text to run horizontally, but occasionally you might want vertical text. Choose your text tool and type it in as usual. If you forget, just highlight it and click the button and your text will change.
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  Another way to edit your text is to use the path effect editor. Change your text to a path (Path > Object to Path), then click Path > Path Effects. Add the effect you want (Bend, for example). In the Path Effects window, choose the edit on canvas tool (the node tool symbol) and you will get a line in your text to manipulate, just like moving nodes. On this one, I grabbed the center of the line and pulled it up.
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  Another path effect is the envelope, which we covered in the December issue.

  

  Have fun adding some more zip and pizzazz to your text in your next Inkscape project.
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  Playing Arcane Legends In PCLinuxOS


  



  by Agent Smith (Alessandro Ebersol)
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  Another good, free to play MORPG, Arcane Legends is a fantasy MMORPG based on browser in 3D by SpaceTime Studios. Unlike traditional browser MMORPGs, Arcane Legends is also available on iOS and Android devices such as tablets and phones, iPad's and Androids are supported. This allows you to play in multiple platforms without the need for a separate account, making it easier for players to play anywhere, whether it be that bus queue, waiting their turn on the bench ...


  Early in the game, players will choose one of three classes including Warrior, Rogue, and Mage. As players progress, each class will unlock various skills that can be specialized in order to customize a preferred style of play by the players. There is no automatic attacks in Arcane Legends. The game instead uses a system more action RPG oriented, in which players must touch or hold the attack button in order to perform a series of quick attacks or a single, more powerful charged attack.
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  The 3 Classes of the game


  Players will also be able to choose a pet at the start of the game. It follows the player around, and comes with its own attributes and skills. Players do not need to collect the drops from the monsters of the game, as his pet will take care of it. The game features over 40 unique animals allowed for players to collect during their journey.


  



  Features of the game


  Graphics


  The graphics are very good, made in a cartoon style. They are the like Playstation 1 graphics, but well-made and colorful. With good graphics, though simple (the polygon count is not high), it guarantees a good performance on all platforms, tablets, mobile phones and even older computers/laptops.
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  Opening Screen



  Gameplay


  There are tons of thugs to destroy through the various game landscapes, with a brief list of upgradeable skills to complement the attacks, quests, leaderboards, a hodgepodge of pets to collect and put to work by the player. There is also an endless variety of drops to collect in various rarity levels. The basics of hack'n'slash games is often lost in translation from PC to phone, but Arcane Legends captures the essence of the genre admirably, having a consistent gameplay on all clients (PC, Mobile and Tablet).


  It is not a difficult game to learn, and it has simple, straightforward gameplay. But, it's a lot of fun. It's easy to enter the mainland of Arlor and pick up the tricks of the game, improving your character from there.
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  Sound


  The sound is very well done, with music composed especially for the game, rather climatic, and with good voice acting and sound effects.


  Main points


  
    	Large persistent world (semi-open), with many different maps to explore.


    	



    	Hack and slash action and combat.


    	



    	Three different classes (Warrior, Rogue, Mage).


    	



    	Many pets to collect and train to fight by your side.


    	



    	Thousands of online players to interact in a persistent world.


    	



    	Over a thousand different weapons, armor and items to discover.


    	



    	Several mounts to travel everywhere in the maps.
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  Requirements: Have a Google Chrome browser updated.

  

  URL: http://www.arcane-legends.com/


  Chrome Web Store: https://chrome.google.com/webstore/detail/arcane-legends/ibmlkgieigeddcedpbijnpojheoddido?hl=en


  

  

  

  [image: ]

  

  [image: ]

  

  [image: ]

  

  [image: ]

  

  [image: ]

  

  [image: ]

  

  [image: ] 


  

  


  My Linux Valentine
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  PCLinuxOS Recipe Corner
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  Sausage and Potatoes Italiano
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  Ingredients


  1 lb bulk Italian pork sausage

  4 cups boiling water

  1 cup milk

  1/4 cup margarine or butter

  2 boxes Betty Crocker™ au gratin potatoes

  1/2 cup chopped green onions (8 medium)

  2 tablespoons sliced green onions (2 medium)


  



  Directions


  1. Heat oven to 400°F. Spray 13x9-inch (3-quart) glass baking dish with cooking spray. In 10-inch skillet, cook sausage over medium-high heat, stirring frequently, until no longer pink; drain.

  

  2. In large bowl, mix water, milk and margarine. Stir in 2 pouches Potatoes and 2 pouches Sauce Mix. Stir in sausage and 1/2 cup green onions until well blended. Pour potato mixture into baking dish.

  

  3. Bake uncovered 35 minutes. Top with 2 tablespoons green onions. Bake 5 minutes longer or until potatoes are tender. Let stand 5 minutes before serving (sauce will thicken as it stands).


  Options: Replace Italian Pork Sausage with hamburger, ham, chicken or turkey.
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  If Your Password Is On This List, CHANGE IT NOW!


  



  by Paul Arnote (parnote)


  Some portions of this article are from the SplashData press release.


  SplashData has released their list of the most common passwords found on the internet. This makes them the worst passwords to use, opening up your accounts and personal data to being easily hacked by nefarious individuals.


  Once again, "123456" and "password" top the list of the worst passwords. They have maintained that ranking since SplashData started releasing their worst passwords list in 2011.
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  SplashData compiled their report from over 2,000,000 (yes, two million) leaked passwords during the year. With this being their fifth annual list, it's quite amazing at how much people put their data at risk with the use of poor, weak and ineffective passwords.


  Here is the 2015 Worst Passwords List Top 25:


  
    
      	Rank  

      	Password  

      	Change from 2014  
    


    
      	1

      	123456

      	Unchanged
    


    
      	2

      	password

      	Unchanged
    


    
      	3

      	12345678

      	Up 1
    


    
      	4

      	qwerty

      	Up 1
    


    
      	5

      	12345

      	Down 2
    


    
      	6

      	123456789

      	Unchanged
    


    
      	7

      	football

      	Up 3
    


    
      	8

      	1234

      	Down 1
    


    
      	9

      	1234567

      	Up 2
    


    
      	10

      	baseball

      	Down 2
    


    
      	11

      	welcome

      	New
    


    
      	12

      	1234567890

      	New
    


    
      	13

      	abc123

      	Up 1
    


    
      	14

      	111111

      	Up 1
    


    
      	15

      	1qaz2wsx

      	New
    


    
      	16

      	dragon

      	Down 7
    


    
      	17

      	master

      	Up 2
    


    
      	18

      	monkey

      	Down 6
    


    
      	19

      	letmein

      	Down 6
    


    
      	20

      	login

      	New
    


    
      	21

      	princess

      	New
    


    
      	22

      	qwertyuiop

      	New
    


    
      	23

      	solo

      	New
    


    
      	24

      	passw0rd

      	New
    


    
      	25

      	starwars

      	New
    

  


  



  For example, "1234567890", "1qaz2wsx" (first two columns of main keys on a standard keyboard), and "qwertyuiop" (top row of keys on a standard keyboard) all appear in the top 25 list for the first time, but they are each based on simple patterns that would be easily guessable by hackers.


  As in past years' lists, simple numerical passwords remain common, with six of the top 10 passwords on the 2015 list comprised of numbers only.


  Sports remain a popular password theme. While baseball may be America's pastime, "football" has overtaken it as a popular password. Both appear in the Top 10 of SplashData's list, with "football" climbing three spots to number seven and "baseball" dropping two spots to number 10.


  When it comes to movies and pop culture, The Force may be able to protect the Jedi, but it won't secure users who choose popular Star Wars terms such as "starwars," "solo," and "princess" as their passwords. All three terms are new entries on this year's list.


  Other passwords appearing on the 2015 list that did not appear on the 2014 list include "welcome", "login" and "passw0rd."


  SplashData, provider of password management applications including SplashID for consumers and TeamsID for businesses (but not for Linux), releases its annual list in an effort to encourage the adoption of stronger passwords to improve Internet security. According to SplashData, the passwords evaluated for the 2015 list were mostly held by users in North America and Western Europe. The "Worst Passwords List" shows that many people continue to put themselves at risk for hacking and identity theft by using weak, easily guessable passwords.


  "We have seen an effort by many people to be more secure by adding characters to passwords, but if these longer passwords are based on simple patterns they will put you in just as much risk of having your identity stolen by hackers," said Morgan Slain, CEO of SplashData. "As we see on the list, using common sports and pop culture terms is also a bad idea. We hope that with more publicity about how risky it is to use weak passwords, more people will take steps to strengthen their passwords and, most importantly, use different passwords for different websites."


  PCLinuxOS users can use KeePassX as a capable password manager. It is available in the PCLinuxOS repository, and can be installed on your computer via Synaptic.


  We have covered password security before in the pages of The PCLinuxOS Magazine. If you want to review our previous articles, here is a list for your convenience.


  September 2013: Password Security Revisited

  April 2007: What's In A Password?

  November 2013: KeePassX: Not In The Cloud

  March 2010: Secure Passwords Made Easy

  September 2009: Secure Passwords With openssl


  To summarize best password practices, do the following:


  
    	Don't use the same username and password on multiple websites.



    	Make your passwords 12 characters or more in length. Longer, complex passwords are harder to hack and crack.



    	Avoid the use of personally identifiable information, like birthdays, anniversaries, telephone numbers, names of wife/girlfriend, children and other family members.



    	Avoid the use of popular hobbies, sports, sports teams, or movie characters/stars, or anything else related to pop culture.



    	Use a mix of letters, numbers and punctuation marks. Vary the case of the letters you use. An "A" and an "a" are not the same on the vast majority of systems.

  


  Also, it's ok to "seed" your unique passwords with a common "root" password. This way, you can easily make each site you visit have a very unique password. For example, seeding all of your passwords with a unique passphrase (e.g. iHearTd3BBi3), you can tailor each site by adding information unique to that site. So, your password for Yahoo! Mail might become iHearTd3BBi3y!MaiL. Or, it could be 16;iHearTd3BBi3yM. You decide how you want to construct your passwords, and don't divulge your methodology to ANYONE!


  You owe it to yourself -- and to the security of your data and personal information -- to protect that which is dear and vital to you, which is YOU!
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  Using Multiple Android APKs With ARC Welder


  



  by Alessandro Ebersol (Agent Smith)
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  Well, now I will discuss about a very cool tip for Arc Welder, the native Android emulator for Google Chrome, and hence, for our PCLinuxOS. As you can see here, usually Arc Welder only allows you to install one APK at a time. The next APK installed removes the previous APK.


  But it is possible to install multiple APK's with Arc Welder.


  How?


  Easy, just follow these steps:


  A) In the Google application menu, start Arc Welder.
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  B) Click on “Add Your APK.”
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  C) Choose the APK you want to install.


  D) Do all the normal configuration process for the Android APK (orientation, screen resolution, tablet or mobile phone.)


  E) Now comes the important part that makes the difference: instead of clicking Launch App, click Download Zip.
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  F) Now the zipped Android APK by Arc Welder should be in the folder /Downloads (or any other that you have set for your downloads).


  G) Next, you must open Google Chrome settings, select Extensions, and enable developer mode.
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  H) Then in your file browser (PCManFM, Caja, Dolphin, etc ...), open the zipped APK package and extract its contents to a folder (can be Chrome_Apks or whatever name you want).


  I) In Chrome, Settings > Extensions, click “Load unpacked extension.”


  

  [image: ]



  J) In the "Open File" dialog that will follow, point to the folder where you extracted the APK zipped package and it's done. It will add the APK Android as a Google Chrome application from the applications menu, and you can repeat the process as many times as you want, installing as many APK's as you want.


  I hope you enjoy, and you should be able to use your favorite APK's on your Android as much in your PCLinuxOS machines.


  Until next month, when I will share some more tips on Arc Welder.
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  PCLinuxOS Heart


  



  
    [image: ]
  


  

  


  Inkscape Tutorial: Five Cool Inkscape Extensions You Must Try


  



  by Khadis


  Inkscape has dozens of extensions that can help us create various designs, illustrations, etc. In the previous issues of this magazine, you have seen many creations that used many techniques involving different extensions. Now, I will show you some cool extensions that you can use in your next designs.


  



  Foldable box
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  Are you often curious about how to create a box design for a product package? Using the Foldable box extension, you can design a product package template easily. Once you access it from Extensions - Render - Foldable box menu, a setting window will appear. There, you can set the box size by setting up the box width, height, and depth. Later, if you need to modify each part of this package design, you only need to ungroup (Ctrl + Shift + G) and the box will turn into editable pieces.


  



  QR code creator
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  QR codes are now everywhere, and QR code creators are also can be found easily on the Internet. But, do we really need a separate QR code creator to put a certain “identity” in our products designed in Inkscape? No. We only need an integrated QR code creator right inside Inkscape, and it is already there, under Extensions - Render - Barcode - QR Code menu.


  It is very easy and it takes no time to setup a ready-to-use QR code. In the setting window, you only need to put “something” in the Text field. In the default setting, the Text field is filled by the Inkscape homepage address. You can fill it with the information you want. Then, in the Size field, you can choose any size of QR code that matches your needs. You can also choose the character encoding you want.


  



  L-system
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  Do you wonder about how to create instant dry bushes for your illustration? Creating bushes from lines and curves can take forever until it's done. Don't worry, you can rely on L-system extension that can be accessed from Extensions - Render menu. With a single click, you will get a perfect bushes illustration. Since we need to understand how the extension is working, for the complete help, we can access the Help menu in the setting window of the extension.


  The similar extension that might help is Random tree extension that can also be accessed from Extensions - Render menu.


  



  Cover template
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  Designing the cover of a book is much more easily done in Scribus, although Inkscape can do the same thing, depending on our creativity. If you want to design a book cover using Inkscape rather than another software, you can access Extensions - Render - Layout - Perfect-Bound Cover Template for a help. You only need to decide the size of the cover (width and height), and start designing it. The guidelines showing the margin limits will be prepared by Inkscape.


  



  Lorem ipsum
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  Lorem ipsum seems to be just useless text. However, it is a very popular template of a paragraph that we can find almost everywhere: brochure templates, tabloid templates, etc. Sometimes, when we are designing publication material, we also need to show it to the client first. And instead of using a final design with the whole text, we can use lorem ipsum paragraph.


  The good news is that lorem ipsum is available in Inkscape and can be accessed from Extensions - Text - Lorem ipsum.
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  Game Zone: STAR WARS Knights of the Old Republic II - The Sith Lords


  



  by daiashi
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  About The Game


  Knights of the Old Republic II is a role-playing video game played from a third-person view that features real-time combat. Combat and interactions with the environment and non-player characters in Knights of the Old Republic II is based on the d20 System as in Star Wars: Knights of the Old Republic. The game begins with the character creation menu that has some race and gender selections available. After your character has been chosen, you will be asked to his or her character's abilities. There are 30 new Force powers. The game has several mini games. The interface has been streamlined from the original game and party management was made easier; for example, the player can now switch between two selected weapon sets in the menu. As in the first game, the player can choose to align with either the light side or the dark side. As you progress through the game, you will encounter many characters to converse with. Your answer will determine your jedi or sith path.


  The combat of Knights of the Old Republic II is identical to its predecessor. Several new lightsaber crystals were added to the game. Each of them is useful for a different situation. The player can use a variety of melee and ranged weapons, including swords and firearms. Fighting unarmed is also an option. A new addition to the game are "prestige classes". These are add-ons to the Jedi classes that were established in Knights of the Old Republic. They let the player character practice in lightsaber combat or Force powers, depending on player choice. Do not let the above phrase "Knights of the Old Republic II is a role playing video game." discourage you.You have complete control over your actions.When your character senses danger, the game will pause and give you a course of action. You can, of course, hit the spacebar to resume and run around or from many opponents if tha'ts your thing.


  The player can travel with up to two fellow game characters at a time, which gain experience points at the same rate as the player character. Equipment and perks for party characters can be selected for different statistical effects or abilities. Players can loot corpses and various environmental objects. The protagonist also has the ability to "influence" their game members by doing things that impress them, the player increases their influence with them. Depending on the level of influence, party members may support the player character unconditionally or turn on the protagonist. The player can also exploit high influence by drawing party members to either the light side or the dark side.


  Previously I wrote on games that had a demo version available. However, this is a purchase only game. At $9.99, it is well worth it if you are a Star Wars fan. I might add as well that the game is 10 years old and still is not going unnoticed. It received a healty update as of 2015.


  Hope you enjoy and "May the Force be with you."


  



  System requirements:


  Fully updated PCLinuxOS and Steam


  



  Hardware:


  
    	OS: PcLinuxOS


    	



    	Processor: Intel Core i3 (2 Cores), AMD A10


    	



    	CPU Speed: 2.2 GHz


    	



    	Memory: 4GB RAM


    	



    	Hard Disk Space: 10 GB


    	



    	Video Card (ATI): Radeon HD 5450


    	



    	Video Card (NVidia): GeForce 440


    	



    	Video Card (Intel): HD 4400


    	



    	Video Memory (VRam): 256MB


    	



    	Controller Support: Steam Controller, Microsoft® Xbox® 360 Controller for Windows® (Wired), Microsoft® Xbox® 360 Games for Windows® Wireless Controller with Adapter, SONY® PS3 DUALSHOCK®3 wireless controller (Wired), SONY® PS4 DUALSHOCK®4 wireless controller (Wired), Logitech Gamepad F310, Logitech Wireless Gamepad F710.


    	


  


  About The Company


  Obsidian Entertainment is an American video game developer whose headquarters is located in Irvine, California. It was founded in 2003 by ex-Black Isle employees Feargus Urquhart, Chris Avellone, Chris Parker, Darren Monahan, and Chris Jones after the closure of Black Isle Studios.


  Although they have created original intellectual property, many of their games are sequels based on licensed properties. Early projects include Star Wars: Knights of the Old Republic II: The Sith Lords and Neverwinter Nights 2, both sequels to games developed by BioWare. The team then developed their first original game, Alpha Protocol, in 2010. It was met with generally mixed reviews. Other notable works from Obsidian include Fallout: New Vegas, Dungeon Siege III, and South Park: The Stick of Truth, all also licensed properties.


  



  Some Gameplay Screenshots
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  Getting It To Run


  Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab if you wish and search for Kotor2. There is no demo for this game. To purchase, it will cost you only $9.99. If you have updated your system, including graphics drivers, you should be good to go.


  Kotor II
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  PCLinuxOS Family Member Spotlight: Buffalo Cowboy


  



  As told to YouCanToo


  What is your name/username?

  I am Gary Williams (AKA Buffalo Cowboy). This is in remembrance of my long lost afro and love of all the Black Cowboys and Buffalo Soldiers of the American West.

  

  How old are you?

  I am sixty-one and looking forward to another click on the meter in February.

  

  Are you married, single?

  Thirty-one years married and still going strong.

  

  How about Kids, Grandkids?

  Two grown and married sons. Five grandchildren.

  

  Do you have pets, what is your favorite?

  I'm a default dog dad for my youngest son's Japanese Shibu Inu.

  

  Are you retired, still working and if working, what do you do?

  I am a Desktop Support Technician in a MS Windows environment for a Contracting Company. I am a senior technician working with a lot of Millennial and Gen X colleagues.

  

  Where do you call home? What is it like? IE: weather, scenery

  Home is Northern Virginia about thirty miles from Washington D.C. Living here is all about the commute into and around D.C. (and how to outwit or survive the legendary traffic snarls on a daily basis).

  

  Weather in this part of the country will definitely give you four distinct seasons. Lately, with the clearly evident Global warming, the seasonal transitions have been almost non existent or lingering unusually long before abruptly switching to full out winter; or like last spring, which was shortened before jumping into full summer bake. The scenery here is still spectacular once you go out into the counties away from I-95.

  

  Where did you go to school and what is your education level?

  I'm a Technical School Graduate with some College. I am the last of a fading breed of technicians that RTFM (I'm an old school Hacker before the media misused and destroyed that term).

  

  What kind of things you like doing? hobbies, travel, fishing, camping?

  I practice Martial Art Aerobics with a mixed group of ladies, the majority of them young enough to be my daughters and conditioned enough to be in the UFC. I keep up with and routinely amaze them at every practice. Every young guy who has come to the class has not lasted more than two classes tops, so far. When not doing weekday routines, I soak up as much free Linux Knowledge as I can from all available sources. Especially the user forum.

  

  Why and when did you start using Linux?

  I wanted to keep this Dell Inspiron 6000 alive when Vista was launched back in 2009. I have never looked back. This laptop runs KDE 4.14.10 and the 4.1.7 pclos3 kernel. I make my money supporting MS in the daytime but use PCLinuxOS exclusively for personal use and have even gotten my wife very comfortable using it, too. So far, I've spread the OS to two sister-in-law's' computers with positive results all around.


  

  



  PCLinuxOS Family Member Spotlight is an exclusive, monthly column by youcantoo, featuring PCLinuxOS forum members. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.

  

  If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.


  

  

  

  [image: ]

  
 [image: ]

  
 [image: ]

  
 [image: ] 


  

  


  Tip Top Tips: How To Install Copy Agent In PCLinuxOS


  



  Editor's Note: Tip Top Tips is a new monthly column in The PCLinuxOS Magazine. Each month, we will feature -- and possibly even expand upon -- one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum's "Tips & Tricks" section. Your tip just may be selected for publication in The PCLinuxOS Magazine.


  This month's tip comes from PCLinuxOS forum member Agent Smith.


  I had to find another storage provider in the "cloud." DropBox is becoming quite restrictive, so to speak.


  I found Copy (http://www.copy.com/), a provider that I found very good. 15 GB free, from the start, with the possibility to increase with references.


  

  [image: ]



  Copy Agent has a native client for Linux. It's available for 32 or 64 bit OS architectures, is very cool, easy to setup, and works very well.


  But, since it has no installer, we have to follow this simple recipe to add it to our PCLinuxOS system.

  

  1. Signup for an account here.

  

  2. Then, download the linux client: https://copy.com/install/linux/Copy.tgz

  

  3. Expand the tgz file. A folder, copy, is created.

  

  4. As root, copy this folder into the folder /opt.

  

  5. Create a .desktop file with your favorite plain text editor. You can call it copy.desktop.

  

  6. The contents of this file should be:


  [Desktop Entry]

  Encoding=UTF-8

  Name=Copy Agent

  Comment=Share Files

  Exec=/opt/copy/x86/CopyAgent (note this line - If your system is a 64 bit one, this line should be: /opt/copy/x86_64/CopyAgent)

  Icon=Copy-FB.png

  Terminal=false

  Type=Application

  StartupNotify=true

  Categories=GTK;Network;X-MandrivaLinux-Internet-RemoteAccess;


  7. Copy the icon from here to /usr/share/pixmaps (you must do this as root).

  

  8. Copy the .desktop file to /usr/share/applications (which also must be done as root).

  

  9. And voila, the Copy Agent icon will appear in your start menu, in the Internet section.


  I hope you enjoy the gigabytes of free storage from Copy.com.
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  ms_meme's Nook: If Ever I Would Leave PCLinuxOS
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  PCLinuxOS Puzzled Partitions


  



  Scrappler
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  Download Puzzle Solutions Here!

  

  



  Sudoku
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  Download Puzzle Solutions Here!

  

  



  Crossword: February2016

  Inkscape Extensions
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  Download Puzzle Solutions Here!

  

  



  Inkscape Extensions Word Find
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  Download Puzzle Solutions Here! 


  

  


  Screenshot Showcase
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  Posted by chilly, January 12, 2016, running KDE
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  Posted by Crow, January 15 , 2016, running KDE
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  Posted by Gonzalo_VC, January 29, 2016, running Mate
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  Posted by HERTZ, January 14, 2016, running LXDE
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  Posted by Ika11, January , 2016, running Fluxbox
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  Posted by OnlyHuman, January 21, 2016, running e17
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  Posted by present_arms, January 1, 2016, running Trinity
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  Posted by tbschommer, January 26, 2016, running Xfce
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  Posted by Vorteggs, January 4, 2016, running LXDE
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  Posted by weirdwolf, January 10, 2016, running LXDE 
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